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Managing Traps and Events

Introduction to Fault Management
One of the most important aspects of network management is the ability to identify events on the sy
and to take action to resolve them quickly and efficiently. For example, there may be a power sup
fault in a chassis that would require an engineer to be sent out to rectify the fault. This fault is critic
the running of the network and would need prompt attention.

In CMNM, when a condition (fault) occurs on a managed object in the network, the system is not
immediately. This notification is shown as an event or alarm and can be viewed with the CEMF E
Browser. The Event Browser is opened from the CEMF Launchpad. A screen similar to Figure 8-
displayed.
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Figure 8-1 Event Browser Screen

The Event Browser provides a tool to manage the network efficiently; you can list, query, and sort a
some events according to how you want to manage the network. Services can be invoked on eve
that faults can be attended to from the screen that shows the event.

Note You can also view events on CEMF maps, however, only the most severe fault on a
managed object is shown on the map icon.

You can have more than one Event Browser session open at any one time. Each Event Browser s
can have different queries specified. All users can see any event. In the Event Browser window, yo
acknowledge that a particular event is one that you are going to deal with, and all other users the
that the event is being handled. When the event is cleared, it is shown in the Event Browser windo
other users know that the event requires no further attention.

When an event is received, it is shown as active and unacknowledged (the two indicators are sho
grey). At this stage, no one has taken responsibility to deal with it. You may not want to view all ev
on the system, so a query can be set up using the CEMF Query Editor to view specific events.

How CEMF Models Events
A CEMF event represents a notification from a managed entity that a certain condition has just occu
These events usually represent error conditions on managed elements.
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Each event is associated with the object for which it provides notification. Therefore, an object can
a number of events related to itself at any one time.

Event Information
The default information stored against all CEMF events includes:

• The object on which the event was raised

• The time the event was raised

• The severity of the event

• A description of the event

• The state of the event.

Descriptions of event state and severity are given below.

Event State

The event state indicates whether the event is acknowledged or unacknowledged and active or c

When a new event is received by the system, its state is active/unacknowledged. You may acknow
the event, which indicates to other users that the event is being handled. Once the event has be
with, you may clear the event. When you cannot clear an event due to an existing problem, it can
returned to the unacknowledged state and subsequently acknowledged or cleared by another us

When an event is in the unacknowledged or acknowledged state, it is counted as being active an
therefore, it is still affecting the state of the object upon which it was raised.

Figure 8-2 State Diagram for Events

After events are cleared, they continue to be stored within the system for a configurable amount of
to maintain an event history for an element. These events can be viewed and manipulated in the
way as any other event.

Colors used to Indicate Severity

Each event has a severity, indicating the importance of the event, and is identified with a correspo
color as shown in Table 8-1.

unacknowledged
unacknowledge

acknowledge

clear

raiseAlarm

clear acknowledged

cleared

Element
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Source Domain

The source domain identifies where an event was generated. In CEMF, the source domain can be
the following:

• SNMP—Event was generated by the managed network

• Internal—Event is generally generated by CEMF

Management Domain

This is the management domain of SNMP trap information. The SNMP MIB specific information
typically defines the equipment type generating a trap.

Event Propagation
In order to make the identification of potential problems easy, CEMF propagates the alarm state 
objects upwards through each object view.

In real terms, this means that if an object receives an event, then not only does it change color to r
its new state, but all parent objects within a view, also change color, to reflect the most severe alar
any of the children. The example in the following diagram shows a typical physical view of the netw
The line cards are contained within the chassis, the chassis within a bay, the bay within a site, and

If a minor alarm was received on Port B, then it, and all of the objects up to the region, turn yello
indicate a potential minor problem, as illustrated in Figure 8-3.

Table 8-1 Colors Used to Indicate Severity

Color Severity of Event

Red Critical

Orange Major

Yellow Minor

Cyan Warning

Green Normal

White Informational
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Figure 8-3 Example Minor Event Propagation

If a critical alarm was then received on Port A, then it, and all of the objects up to the region, turn re
indicate a potential critical problem, as illustrated in Figure 8-4.

Figure 8-4 Example Critical Event Propagation

If the critical alarm is then cleared, the icons return to yellow.

How CMNM Manages Faults
CMNM provides fault management of the Cisco MGC node, including the Cisco MGC host, the
Cisco SLT, and the LAN switch. Traps generated by these elements are displayed within the CEM
system. When an alarm is received for an object, a pop-up balloon on Map Viewer shows the nu
and severity of the alarms for that object. The balloon color indicates the severity of the most sev
alarms. The fault management features of the Cisco MGC allow you to view, acknowledge, and c
alarms for a given object.

CMNM handles numerous connectivity traps. CMNM defines the necessary trap mappings and
containment trees, allowing CMNM to delegate all traps relating to the connectivity network to the no
that represent it. You can display these alarms in the Event Browser.

When the Cisco MGC host detects a problem with one of its logical connections, it generates a t
CMNM receives these traps and maps them to the object that represents that logical connection
example, if CMNM receives a trap that the link to a media gateway is down, CMNM maps that tra
the object that represents the media gateway link and displays an alarm icon on the Map Viewer

Site

Chassis

Line card A Line card B

Port BPort A Port C
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CMNM maps the incoming traps to alarms. However, not all traps are mapped to alarms. CMNM fil
out duplicate traps from a network element. It also filters out traps from network elements that rep
problem, and then reports within a few seconds (up to 6) when the problem is resolved. That is, 
Cisco MGC automatically clears existing alarms when a network element reports that an alarm cond
is no longer present. This reduces the number of unnecessary alarms displayed in the Event Bro
You cannot configure when an alarm should be automatically cleared.

Presence/Status Polling
CMNM periodically polls each managed object (the Cisco MGC host, Cisco SLT, Cisco MGX 826
LAN switch, and BAMS) to ensure that the device is still reachable using SNMP. If the device is n
reachable, it is indicated by annotation on the map display and an alarm is generated. In addition
object is placed into the CEMF errored state.

After the object loses connectivity, CEMF continues to poll the object until it can be reached. On
connectivity is reestablished, the alarm is cleared and the annotation on Map Viewer is removed
addition the object is returned to the CEMF normal state.

CMNM also displays the status of the Cisco MGC host connectivity network. This includes the log
connections from the active Cisco MGC host to the:

• Interfaces (Ethernet, TDM)

• STPs

• Point codes (SS7 Routes)

• Remote MGCs

• TCAP nodes

• Cisco Media Gateways

The logical connections from the active Cisco MGC host are shown as subnodes under the comm
Cisco MGC host object. If the standby Cisco MGC host is not processing calls, only the network
connectivity of the active Cisco MGC host is shown.

How CMNM Manages Multiple IP Addresses for Presence Polling
By default, each CEMF object can contain only a single IP address. For example, when the user de
a Cisco SLT, the user can specify only a single IP address. CEMF uses this IP address for all manag
transactions including presence polling and performance polling. In addition, the IP address is us
map incoming faults to the CEMF object. When a trap arrives from the network element, CEMF mat
the IP address of the trap sender to the IP address of an object in the database.

In reality, a physical device may have more than one IP address. Traps may come from any interfa
the device. Since CEMF/CMNM is aware of only a single IP address, traps received from an alte
interface might be dropped.

Any interface on the device may go down (either operationally or administratively). If the managem
interface goes down, all SNMP-based operations fail. That is, not all SNMP queries are completed
does status polling or performance polling function. CMNM is designed to avoid these situations
using trap proxies and IP address failover, which are described in the following sections.
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Trap Proxies

To prevent the dropping of traps received from an alternate interface, CMNM models each IP addre
the device. When a trap comes in on any interface, it is mapped to its logical chassis object.

During auto-discovery, the RFC1213-MIB.ipAddrTable is queried.  Each IP address is deployed a
child of its corresponding interface (see Figure 8-5).

Figure 8-5 Multiple IP Address Proxies

The IP Proxy object acts as stand-in for its network element. When a trap is received from the net
element, it is bound for one of the IP proxy objects. Internally, CMNM redirects the trap to the prox
object. For example, all traps received on any Cisco SLT interface are redirected to the SLT Cha
object. In this way all traps on all interfaces are shown, logically, on the object that represents th
device.

IP Address Failover

Since CMNM models each IP Address on the device, it is possible to implement an IP address fai
mechanism. When a device is first deployed, the user specifies an IP address on the manageme
interface. If the management interface goes down or the management addresses becomes unre
CMNM automatically fails over to another IP address. When the management interface/IP addre
restored, CMNM resumes using it for all device communication.

CMNM periodically polls each IP address to ensure that that route is reachable via SNMP. If the
management IP address becomes unreachable, CMNM searches for a new IP address using the fo
rules:

• If any IP address is available on the current management interface, it is used.

• If the current management interface is down, each additional interface is searched, starting w
Ethernet interfaces.

When CMNM searches for an alternate interface, it starts with the Ethernet interfaces. If none ar
available, it attempts to use any other available interfaces (for example TDM interfaces on a Cisco S
Once a usable interface is found, CMNM must decide which IP address to use on that interface. Be
there is no way to distinguish IP addresses, CMNM simply uses the first available IP address child o
interface. Technically this should be the first IP address defined in the ipAddrTable for that interfa

If no IP addresses are available (they are all unreachable), CMNM raises a critical alarm on the cha
This alarm indicates that the device is truly unreachable and requires immediate operator attenti
Once at least one IP address is restored, the alarm is automatically cleared.
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Status Polling

CMNM periodically polls each IP address to see if is reachable via SNMP by sending an SNMP 
message to the IP address object, retrieving the value of the SNMP:RFC1213-MIB.sysUpTime attr

If the attribute is available, it assumed the IP address is reachable. Otherwise, the IP address is
unreachable and is transitioned into the unreachable state. Once connectivity is reestablished, the
is transitioned back into the normal state.

Besides performing status polling on each IP address object, CMNM also performs status polling
various other components.  These include:

• Network interfaces

• Cisco MGC node devices

Network Interface Status

CMNM performs status polling to reflect the state of each network interface. Depending on the
operational and administrative status of the interface, the object representing the network interfa
transitioned into different state as indicated in Table 8-2.

Note that the chassis is queried for the state of its interfaces. That is, the status of the interface re
by CMNM is identical to the status reported by the chassis on its current management IP addres
However, the status of each interface is reported by the chassis via that object's specific IP addres
this way CMNM can better reflect the true health of the chassis.

Interface Alarms

When a network interface goes down, the device sends a link down trap to CMNM. When CMNM de
this trap, it transitions the object representing that interface to the down state. To handle the case
CMNM may have missed a trap, the status polling mechanism raises an alarm if it detects that th
interface is down. When the interface comes back up, the device raises a link-up trap. If CMNM de
this trap, it transitions the interface back into the normal state. If CMNM missed this trap, the next s
poll will detect that the interface is back up. Internally, CMNM transitions the interface back to th
normal state and clears the appropriate alarms on the object.

When an interface goes down, all IP address on that interface become unreachable. Since, durin
next status-poll cycle, all IP addresses on that interface will fail, CMNM automatically transitions al
the child IP address objects into the unreachable state. Doing so prevents a potential flood of ala

Table 8-2 Network Interface States

Admin Status Operational Status Network Interface State

Up Up up

Up Down down

Up In Test in-test

In Test N/A in-test

Down N/A off-duty

<not reachable> N/A unreachable
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MGC Host Status

CMNM periodically checks the status of each MGC Node device.  The attribute
SNMP:CISCO-TRANSPATH-MIB.tpCompOpStatus is retrieved and its value is used to determine
required state of the object as indicated in Table 8-3

.

BAMS Status

CMNM periodically checks the status of each BAMS device. The
SNMP:ACECOMM-BAMS-SYSPARM-MIB.sysStatus attribute is retrieved and its value is used to
determine the required state of the object as indicated in Table 8-4

.

Polling Frequency

CMNM allows the user to configure status polling frequencies for each type of device. For example
user can set the status polling frequency for Cisco SLT devices to be different than that of the
Cisco MGC host devices.

The status polling frequency controls the rate at which the IP Address objects are polled. In addi
this frequency is used to determine the rate at which the status of the various devices is queried

Given the polling interval, all objects are polled at some point in that interval. For example, if the st
polling frequency for a Cisco SLT is set to 5 minutes, all IP address objects on all Cisco SLTs are p
at some point during a five-minute interval.

Manual SNMP Query

Besides the periodic polling, CMNM provides a mechanism to check the SNMP visibility of a device
set of devices. You can click a button that causes a manual SNMP poll to occur. The results of th
manual poll are displayed.

Table 8-3 Cisco MGC Host States

Component Status Network Interface State

ACTIVE active

STANDBY standby

OOS oos

<no answer> not-running

<not reachable> unreachable

Table 8-4 BAMS States

Component Status Network Interface State

active active

standby standby

outage oos

other other

<no answer> not-running

<not reachable> unreachable
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How Traps Are Managed for Network Devices
The following sections outline the southbound traps that are handled from the network elements. CM
does not handle every possible trap that can be generated from each of the network elements, only
traps that are used for management of the devices.

CMNM converts traps to alarms which are displayed in the Event Browser. For the Cisco SLT, th
Catalyst LAN switches, and the Cisco MGX 8260, each trap has a corresponding CMNM alarm. 
example, the linkDown trap from the Cisco SLT corresponds to the “Link down” Event Descriptio
the CMNM Event Browser. For the BAMS and the Cisco MGC, the trap serves as an envelope tha
carry any one of numerous alarm messages.

In addition to device-specific traps, CMNM generates internal alarms. Appendix A, “BAMS, Cisco
MGC, and CMNM Messages” provides an explanation of these internal messages and reference
documentation on alarm messages from the BAMS and the Cisco MGC.

BAMS Alarms
All BAMS alarms are carried on a single trap, the AlarmTrap.

See Appendix A, “BAMS, Cisco MGC, and CMNM Messages” for references to documentation o
BAMS alarms.

Cisco SLT Alarms

Table 8-5 BAMS Traps

Trap MIB

nusageAlarmTrap ACECOMM-NUSAGE-MIB

Table 8-6 Cisco SLT Alarms

Alarm/Trap MIB Explanation

coldStart SNMPv2-MIB The device was started from a
power-off state.

Note Clear this event manually.

warmStart SNMPv2-MIB The device was restarted from an on
state.

Note Clear this event manually.

linkUp IF-MIB An interface is up after being down.

linkDown IF-MIB An interface is down. This is cleared
by one or more Link Up traps for the
same interface.
8-10
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Catalyst LAN Switch Alarms

Catalyst 5500 Alarms

authenthicationFailure SNMPv2-MIB The device received an SNMP
message that was improperly
authenticated.

syslogAlarm CISCO-SYSLOG-MIB

configChange CISCO-CONFIG-MAN-MIB-VISMI There has been a configuration
change. (Informational)

Table 8-6 Cisco SLT Alarms

Alarm/Trap MIB Explanation

Table 8-7 Catalyst 5500 Alarms

Alarm/Trap MIB Explanation

coldStart SNMPv2-MIB The device was started from a
power-off state.

Note Clear this event manually.

warmStart SNMPv2-MIB The device was restarted from an on
state.

Note Clear this event manually.

linkUp IF-MIB An interface is up after being down.

linkDown IF-MIB An interface is down. This is cleared
by one or more Link Up traps for the
same interface.

authenticationFailure SNMPv2-MIB The device received an SNMP
message that was improperly
authenticated.

configChange CISCO-CONFIG-MAN-MIB-VISMI There has been a configuration
change. (Informational)

switchModuleUp CISCO-STACK-MIB A module is up after being down.

switchModuleDown CISCO-STACK-MIB A module is down.
8-11
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Catalyst 2900 Alarms

Table 8-8 Catalyst 2900XL Alarms

Alarm/Trap MIB Explanation

coldStart SNMPv2-MIB The device was started from a
power-off state.

Note Clear this event manually.

warmStart SNMPv2-MIB The device was restarted from an on
state.

Note Clear this event manually.

linkUp IF-MIB An interface is up after being down.

linkDown IF-MIB An interface is down. This is cleared
by one or more Link Up traps for the
same interface.

authenthicationFailure SNMPv2-MIB The device received an SNMP
message that was improperly
authenticated.

syslogAlarm CISCO-SYSLOG-MIB

configChange CISCO-STACK-MIB There has been a configuration
change. (Informational)

Table 8-9 Catalyst 2900 Alarms

Alarm/Trap  MIB Explanation

coldStart SNMPv2-MIB The device was started from a power-off
state.

Note Clear this event manually.

warmStart SNMPv2-MIB The device was restarted from an on state.

Note Clear this event manually.

linkUp IF-MIB An interface is up after being down.
8-12
Cisco Media Gateway Controller Node Manager User Guide 1.5

78-12214-01



Chapter 8      Managing Traps and Events
How Traps Are Managed for Network Devices

e for
 to
Cisco MGC Host Alarms
CMNM handles the traps in Table 8-10 from the Cisco MGC hosts. Each trap is used as an envelop
alarms of that type. See Appendix A, “BAMS, Cisco MGC, and CMNM Messages” for references
documentation on MGC alarms.

MGC Host and BAMS Resource Alarms
CMNM traps application-related events that occur on the Cisco MGC hosts or the BAMS.

linkDown IF-MIB An interface is down. This is cleared by one
or more Link Up traps for the same
interface.

authenthicationFailure SNMPv2-MIB The device received an SNMP message that
was improperly authenticated.

configChange CISCO-STACK-MIB There has been a configuration change.
(Informational)

switchModuleUp CISCO-STACK-MIB A module is up after being down.

switchModuleDown CISCO-STACK-MIB A module is down.

Table 8-9 Catalyst 2900 Alarms

Alarm/Trap  MIB Explanation

Table 8-10 Cisco MGC Host Traps

Trap MIB

qualityOfService CISCO-TRANSPATH-MIB

processingError CISCO-TRANSPATH-MIB

equipmentError CISCO-TRANSPATH-MIB

environmentError CISCO-TRANSPATH-MIB

commAlarm CISCO-TRANSPATH-MIB

Table 8-11 Resource Alarms

Alarm/Trap MIB Explanation

critAppDown CRITAPP-MIB A critical application is down.

critAppUp CRITAPP-MIB The application is up after being down.
This clears the above alarm.

siFsAboveWarningThreshold SIFSMONITOR-MIB A monitored file system usage percentage
is above the warning threshold.
8-13
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Cisco MGX 8260 Alarms

Alarm/Trap MIB Explanation

siFsBelowWarningThreshold SIFSMONITOR-MIB The monitored file system usage is below
the warning threshold. This clears the
above alarm.

siFsAboveCriticalThreshold SIFSMONITOR-MIB A monitored file system usage percentage
is above the critical threshold.

siFsBelowCriticalThreshold SIFSMONITOR-MIB The monitored file system usage is below
the critical threshold. This clears the
above alarm.

Table 8-12 Cisco MGX 8260 Traps and Alarms

Trap  MIB Alarm Description

coldStart SNMPv2-MIB The device was started from a power-off state.

Note Clear this event manually.

warmStart SNMPv2-MIB The device was restarted from an on state.

Note Clear this event manually.

linkUp IF-MIB An interface is up after being down.

linkDown IF-MIB An interface is down. This is cleared by one or more Link
Up traps for the same interface.

authenthicationFailure SNMPv2-MIB The device received an SNMP message that was
improperly authenticated.

Table 8-11 Resource Alarms

Table 8-13 Additional Cisco MGX 8260 Traps

Trap MIB

shelfMajorAlarm mms1600_trap

shelfMinorAlarm mms1600_trap

shelfAlarmClear mms1600_trap

shelfSecurityAlert mms1600_trap

shelfColdStart mms1600_trap

    shelfHistoryChg  mms1600_trap

    cardInserted  mms1600_trap

    cardRemoved  mms1600_trap
8-14
Cisco Media Gateway Controller Node Manager User Guide 1.5

78-12214-01



Chapter 8      Managing Traps and Events
How Traps Are Managed for Network Devices
    cardFailed  mms1600_trap

    cardCoreSwitched  mms1600_trap

    cardServiceSwitched  mms1600_trap

    cardMajorAlarm  mms1600_trap

    cardMinorAlarm  mms1600_trap

    cardAlarmCleared  mms1600_trap

    cardActive  mms1600_trap

    cardCoreRedFailed  mms1600_trap

    cardSmRedFailed  mms1600_trap

    cardMsmMajorAlarm  mms1600_trap

    cardMismatched  mms1600_trap

    cardCfgCleared  mms1600_trap

    cardInStdby  mms1600_trap

    cardBackInserted  mms1600_trap

    cardBackRemoved  mms1600_trap

    dsx1LineAdded  mms1600_trap

    dsx1LineDeleted  mms1600_trap

    dsx1LineModified  mms1600_trap

    dsx1MajorAlarm  mms1600_trap

    dsx1MinorAlarm  mms1600_trap

    dsx1AlarmClear  mms1600_trap

    dsx1PerfMajorAlarm  mms1600_trap

    dsx1PerfMinorAlarm  mms1600_trap

    dsx1PerfAlarmCleared  mms1600_trap

    dsx1UpdateThreshold  mms1600_trap

    dsx1PayloadLoopup  mms1600_trap

    dsx1LineLoopup  mms1600_trap

    dsx1OtherLoopup  mms1600_trap

    dsx1LineLoopDown  mms1600_trap

    dsx1LineBertOn  mms1600_trap

    dsx1LineBertOff  mms1600_trap

    dsx3LineAdded  mms1600_trap

    dsx3LineDeleted  mms1600_trap

    dsx3LineModified  mms1600_trap

    dsx3MajorAlarm  mms1600_trap

    dsx3MinorAlarm  mms1600_trap

Table 8-13 Additional Cisco MGX 8260 Traps

Trap MIB
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    dsx3AlarmClear  mms1600_trap

    dsx3PerfMajorAlarm  mms1600_trap

    dsx3PerfMinorAlarm  mms1600_trap

    dsx3PerfAlarmCleared  mms1600_trap

    dsx3UpdateThreshold  mms1600_trap

    dsx3PayloadLoopup  mms1600_trap

    dsx3LineLoopup  mms1600_trap

    dsx3OtherLoopup  mms1600_trap

    dsx3LineLoopDown  mms1600_trap

    etherLineAdded  mms1600_trap

    etherLinedeleted  mms1600_trap

 etherLineConfigChange  mms1600_trap

    etherLineActive  mms1600_trap

    etherLineInActive  mms1600_trap

    etherLineFailed  mms1600_trap

etherLineAlarmCleared  mms1600_trap

    voicePortAdded  mms1600_trap

    voicePortDeleted  mms1600_trap

    voicePortDeleted  mms1600_trap

    voicePortModified  mms1600_trap

    emmMajorAlarm  mms1600_trap

    emmMinorAlarm  mms1600_trap

    emmAlarmClear  mms1600_trap

    clockMajorAlarm  mms1600_trap

    clockMinorAlarm  mms1600_trap

    clockAlarmCleared  mms1600_trap

    clockSwitched mms1600_trap

    dmcM13MapAdded  mms1600_trap

    dmcM13MapDeleted  mms1600_trap

    dmcM13MapModified  mms1600_trap

    dspMinorAlarm  mms1600_trap

    dspMajorAlarm  mms1600_trap

Table 8-13 Additional Cisco MGX 8260 Traps

Trap MIB
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Trap Receipt Not Guaranteed

CMNM does not provide any guarantee that it received a trap from the southbound systems or ne
elements. CMNM does not perform any negotiation with the network elements to detect or recove
traps. However, you can perform presence polling to display trap data that may have been lost.

How Traps Are Cleared Using Correlation Files
CMNM can clear alarms using CEMF Clear Correlation files. On receipt of an incoming clear alarm
rules defined in these files indicate which active alarms on a given object should be cleared. For exa
a link-up alarm clears a link-down alarm, a process normal alarm clears a process error alarm, a
communication success alarm clears a communication failure alarm.

A sample Clear Correlation file is:

CLEAR_CORRELATION_RULE

INCOMING_ALARM_CLASS linkUpAlarmClass

ALARM_CLASS_TO_CLEAR linkDownAlarmClass

END_RULE

When a clear condition is received, the cleared alarm is automatically removed from the appropr
screens and the clear alarm is forwarded to northbound systems like any other alarm.

The following sections map the alarms to their clear conditions for each Cisco MGC node device

Cisco MGC Host Clear Correlation
Table 8-14 maps the alarms to their clear conditions for the Cisco MGC host.

Cisco SLT Clear Correlation
Table 8-15 maps the alarms to their clear conditions for the Cisco SLT.

Table 8-14 Cisco MGC Host Clear Correlation

Alarm Clear Condition

processingError processingNormal

communicationFailure communicationSuccess

qualityOfServiceError qualityOfServiceNormal

equipmentError equipmentNormal

environmentError environmentNormal
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LAN Switch Clear Correlation
Table 8-16 maps the alarms to their clear conditions for the LAN switch.

Table 8-15 Cisco SLT Clear Correlation

Alarm Clear Condition

IF-MIB.linkDown IF-MIB.linkUp

Table 8-16 LAN Switch Clear Correlation

Alarm Clear Condition

IF-MIB.linkDown IF-MIB.linkUp

CISCO-STACK-MIB.switchModuleDown CISCO-STACK-MIB.switchModuleUp
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CIAgent Clear Correlation
Table 8-17 maps the alarms to their clear conditions for the CIAgent.

Forwarding Traps to Other Systems
CMNM provides forwarding of traps generated by each component of the Cisco MGC node (the
Cisco MGC host, Ciso SLT, BAMS, and LAN switch) to northbound systems.

Note If you plan to configure CMNM to forward traps to northbound systems, you should
configure SNMP Version 1 traps only on network devices. CMNM only forwards SNMP
Version 1 traps to northbound systems. For more information on configuring SNMP on
network devices, see Chapter 3, “Configuring Network Devices for Management.”

Traps are forwarded to the northbound systems using standard SNMP transport. To receive trap
northbound systems must register with CMNM. If the northbound system wants to receive standa
SNMP traps, you must manually enter the IP address of the northbound system in CMNM. CMNM e
provides a dialog where this information is entered or you must deploy an object that represents
northbound system.

To forward traps to another system:

Step 1 Select the MGC-Node-View icon icon on the Map Viewer.

Step 2 Right-click to display the pull-down menu, selectTools, thenOpen Trap Forwarding.

You see the screen in Figure 8-6.

Table 8-17 CIAgent Clear Correlation

Alarm Clear Condition

CRITAPP-MIB.critAppDown CRITAPP-MIB.critAppUp1

1. The varbind criaAppName in the trap/clear must match.

CRITAPP-MIB.critAppNotAllRunning CRITAPP-MIB.critAppAll
Running

SIFSMONITOR-MIB.siFsBelowWarningThreshold SIFSMONITOR-MIB.siFs
AboveWarningThreshold2

2. The varbind siFsMonName in the trap/clear must match.

SIFSMONITOR-MIB.siFsBelowCriticalThreshold SIFSMONITOR-MIB.siFs
AboveCriticalThreshold3

3. The varbind siFsMonName in the trap/clear must match.
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Figure 8-6 Trap Forwarding Screen

Step 3 Next to Trap Forwarding Address, enter the IP address to which you want to forward traps and clickAdd.

You see the screen in Figure 8-7.

Figure 8-7 Action Report Screen

Step 4 Click Close, then close the Trap Forwarding screen shown in Figure 8-6.

Step 5 Select the MGC-Node-View icon on the Map Viewer, right-click to display the pull-down menu, sel
Tools, thenOpen Trap Forwarding.

You see the Trap Forwarding screen shown in Figure 8-6 with the IP address you specified added
left pane.
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Note To remove an IP address, from the Trap Forwarding screen select the IP address,
selectActions, then selectRemove. You see a screen confirming your action. Click
OK .

Opening the Event Browser
The Event Browser application is launched using the icon in the CEMF Launchpad screen.
Query Editor window is displayed.
Set your query (the Event Browser displays events that match the query criteria). For more informa
see the “Filtering Events Using Queries” section on page 8-23.

From the pop-up menu available when you right-click one or more objects in the Map Viewer (the E
Browser displays only the events associated with the selected objects), or from other CEMF applica
select theEvent Browser option.

Overview of the Event Browser Screen
The main panel in the Event Browser window, shown in Figure 8-8, displays a list of events inclu

• Object name (the managed device’s name)

• Time the event was raised

• Severity of the event (color-coded)

• Description of the event

Two indicators, color-coded to the severity of the event, are available to the left of the object nam

• Clear (an indicator to show if an event is active or cleared)

• Ack (an indicator to show if an event is acknowledged or unacknowledged).

Click Ack to indicate to other users that the fault is being worked on. The button changes to the col
the severity, in this case, red. If for any reason you cannot clear the problem, this button can be dese
so the event can be reassigned. ClickClear when the fault has been rectified to indicate that the eve
requires no further attention.

Note The option to unacknowledge an event is available only to an administrator or to the user
who acknowledged the event initially.
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Figure 8-8 Event Browser Screen

Menus are available that provide you with options for modifying the way the information is display
From the Edit menu, you can:

• Set up the Event State (Clear Events, Acknowledge, or Unacknowledge Events)

• Set up queries to specify the events you want to see

• Set up sort options to present the events in the order you want

From the View menu you have the following options to manage the way events are viewed on ea
object:

• Use Auto or Manual Update

• Set the Color Coding

• View the Event History window

• Refresh the Event Browser window

• Display the Full Object Name

• Select Full Name Options

ACK
indicator

Total number of
events displayed

Clear
indicator

Time event
was raised

Severity

Current query

Object name;
Full object

name displayed

Current sort orderStatus barUpdate staus

Partial color coding
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The Full Event Description window allows you to view the status of a selected event. For more
information, refer to the “Viewing a Full Description of an Event” section on page 8-36.

Clicking an event severity, name, time, or description selects that event. One or more events can
selected; this gives the opportunity to perform bulk operations. With one or more events selected
clicking the right mouse button displays a pop-up menu that shows the common services availab
those events.

The Event Browser window also displays other information in the status bar:

• Progress bar (indicates that events are being added to the display)

• Current Update status (this can be auto or manual)

• Current query

• Current sort order, for example, sort by time

• Total number of events displayed (This number is shown in blue until it is acknowledged by the
by clicking the number.)

Note The Event Browser can display a maximum of 10,000 entries. If there are more
events on the system, this is indicated in the status bar.

In the Event Browser, you can use Print to save the contents of all or part of the browser to a file
print a paper copy.

Filtering Events Using Queries
The Event Browser monitors all events on all devices. To work efficiently, you may want to specify
objects on the network with which you are concerned. The Event Browser gives you the option to do
through queries that can be configured to match your requirements. With queries you can choos
include or exclude devices or criteria. For example, you could choose to monitor a particular dev
specify a time period, and choose to look only at events that are warnings or are critical. You def
query so that the Event Browser displays only the events that meet the criteria you defined.

Note Any changes made to the queries are not stored after exiting the Event Browser.

Opening the Query Editor
To define a query, click the  icon in the CEMF Launchpad window, or

in the Event Browser, select theEdit  menu’sQuery Setup option, or

click the Query Filter icon  from the Toolbar.

The Query Editor window, similar to Figure 8-9, is displayed. The criteria that can be used to spec
query are available on individual tabs. Values or criteria can be selected on each tab. A dark gray
active (On); its query is used in the Event Browser. A light gray tab is inactive (Off); its query is not u
8-23
Cisco Media Gateway Controller Node Manager User Guide 1.5

78-12214-01



Chapter 8      Managing Traps and Events
Filtering Events Using Queries

g

 that
ed is
Figure 8-9 Query Editor Screen

The Query Editor is split into the following tabbed sections (see the next section, “Setting Filterin
Criteria,” for more information):

• Severity

• Time

• Event Status

• Source Domain

• Mgmt Domain

• User

• Event Class

• Object Scope

• Object Class

• Object Attribute Presence

• Object Attribute Value

The Event Browser is updated with events that match the query criteria. A progress bar indicates
CEMF is querying for events and the window is being updated. The total number of events display
shown in blue until you acknowledge it by clicking on the number.

Setting Filtering Criteria
To set filtering (query) criteria:

Step 1 From the Query Editor screen, click theSeverity tab.

You see the screen in Figure 8-10.
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Figure 8-10 Query Editor Screen—Severity Tab

Step 2 From the Available Values list, select the desired alarm level.

Step 3 Click the right arrows to transfer the alarm level to the Selected Value list.

Step 4 Click theTime tab.

You see the screen in Figure 8-11.

Figure 8-11 Query Editor Screen—Time Tab

Step 5 Select the time range and the date range for collecting the alarms.

Step 6 Click theEvent Status tab.
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You see the screen in Figure 8-12.

Figure 8-12 Query Editor Screen—Event Status Tab

Step 7 From the Available Values list, select the events and click the right arrows to transfer them to the
Selected Values list.

Step 8 Click theSource Domain tab.

You see the screen in Figure 8-13.

Figure 8-13 Query Editor Screen—Source Domain Tab

Step 9 From the Available Values list, select Domain values and click the right arrows to transfer the value
the Selected Values list.

Step 10 Click theMgnt Domain tab.

You see the screen in Figure 8-14.
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Figure 8-14 Query Editor Screen—Mgmt Domain Tab

Step 11 From the Available Values list, select management domains and click the right arrows to transfer
values to the Selected Values list.

Step 12 Click the arrows on the right side of the tabs to scroll to additional tabs.

Step 13 Click theUser tab.

You see the screen in Figure 8-15.

Figure 8-15 Query Editor Screen—User Tab

Step 14 From the Available Values list, select users and click the right arrows to transfer the values to the
Selected Values list.

Step 15 Click theEvent Class tab.

You see the screen in Figure 8-16.
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Figure 8-16 Query Editor Screen—Event Class Tab

Step 16 From the Available Values list, select event classes and click the right arrows to transfer the values
Selected Values list.

Step 17 Click theObject Scope tab to display all the events of a node and all its children.

You see the screen in Figure 8-17.

Figure 8-17 Query Editor Screen—Object Scope Tab

Step 18 Click Add Scope.

You see the screen in Figure 8-18.
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Figure 8-18 View Scope Selector Screen

Step 19 In the View Scope selector, select the node.

Step 20 Type the number of levels to view. This can be more than needed.

Step 21 Click the diamond to the left of Descendants and clickApply.

Step 22 On the Query Editor screen, click theObject Classes tab.

You see the screen in Figure 8-19.
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Figure 8-19 Query Editor Screen—Object Class Tab

Step 23 From the Available Values list, select the desired object classes and click the right arrows to transfe
values to the Selected Values list.

Step 24 Click theObject Attribute Presence tab. Click a pull-down menu under Object Type to select a val
and click a pull-down menu under Attribute Name to select a value, as shown in Figure 8-20.

Figure 8-20 Query Editor Screen—Object Attribute Presence Tab

Step 25 Click theObject Attribute Value tab. Click a pull-down menu under Object Type to select a value, clic
a pull-down menu under Attribute Name to select a value, and click a pull-down menu under Attr
Value to select a value, as shown in Figure 8-21.
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Figure 8-21 Query Editor Screen—Object Attribute Value Tab

Step 26 After all values are set, clickApply  and close the Query Editor.

You see the following message:

Save Query Changes?

Step 27 Click Yes.

The Event Browser begins collecting the data using the criteria you selected and displays it in the E
Browser window.

Note Query changes are saved for the immediate session only. When you close the Event
Browser, the query criteria is reset to the default.

Modifying Filtering Criteria
You can change the alarm criteria displayed in the Event Browser at any time by launching the Q
Editor and changing the values.

Step 1 To change the criteria, from the Edit menu on the Event Browser, selectQuery Setup, as shown in
Figure 8-22.
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Figure 8-22 Event Browser—Edit>Query Setup Option

Step 2 Set up the query by selecting values as described in the “Setting Filtering Criteria” section on page

Step 3 Close the Query Setup screen. The Event Browser displays the data.

Sorting Events
Query Editor configuration allows you to specify the events you want to see. Sorting gives you opt
to change the order in which you view the events that match your query criteria.

Setting Up Sort Options
From the Edit menu, selectSorting Options. A pull-down menu is displayed listing the available sorting
options. An indicator shows which option is selected. Selecting an option causes the Event Brow
display to change to show the appropriate information. The sort option selected is shown in the s
bar. You can sort by:

• Time—Shows the most recent event first

• Event Class—Allows you to sort event classes

• Event State—If the query is set up to show all states, this option shows events in the following or

– Unacknowledged/Active

– Acknowledged/Active

– Cleared/Unacknowledged

– Cleared/Acknowledged.

• Managed Object—Sorts by the name of the managed object on the network

Note Set the option to show full name before sorting by name.

• Severity— If the query was set up to show all severities, this option shows events in the follow
order:

– Critical

– Major

– Minor

– Warning

– Normal
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– Decommission

– Informational

Managing Events
When the Event Browser shows a sorted list of events that match the query criteria set, you can s
manage those events. This is the place to acknowledge an event, which shows that you have tak
responsibility for managing that event. If you cannot continue to manage an event, it can be
unacknowledged and then becomes available to other users.

Note The option to unacknowledge an event is available only to an administrator or to the user
who acknowledged the event initially.

When the fault has been rectified and the event requires no further attention, clear the event. It is
removed from the Event Browser.

Three methods are available for managing events:

• Two indicators (Clear and Ack) are available to the left of the object name. Select or deselec
indicator associated with an event in the Event Browser window.

• Use the Edit menu.

• Right-click a selected event to display a pop-up menu of options available on that event.

Clicking an event severity, name, time, or description selects that event. One or more events can
selected; this gives you the opportunity to perform bulk operations.

Managing an Event from the Window

Step 1 To clear the event, select the indicator associated with the event or select the object and click theClear
Events icon  on the Toolbar.

This displays the Events Clearing window. Enter the reason for clearing the event, then clickApply  to
save or clickCancel to exit the window without saving. The indicator changes to the new color of t
severity of the event.

Step 2 Select theAck indicator to acknowledge an event. The indicator changes to the color of the severit
the event. To unacknowledge an event, select theAck indicator, which is then shown as deselected.

Note This option is available only to the user who acknowledged the event or to a user
with administrative access.
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Managing an Event from the Menu Bar
From the Edit menu, you can select theEdit Event Stateoption. A pull-down menu is displayed, which
provides options to manage the events.

• Clear Events—Allows you to clear the event. When you select this option, the Events Clearin
window is displayed. Enter a reason then clickApply  to save the details or clickCancel to exit
without saving.

• Acknowledge Events—Allows you to acknowledge an event.

• Acknowledge Events with comment—Allows you to record a reason for acknowledging an ev
When you select this option, the Acknowledge Events window is displayed. Enter a reason th
click Apply  to save the details or clickCancel to exit without saving.

• Unacknowledge Events—Allows you to unacknowledge an event.

Note This option is available only to the user who acknowledged the event or to a user with
administrative access.

Enabling Auto or Manual Update
Auto Update is the default state and allows you to view incoming events that are automatically upd
in the window.

The status box displays the current update state, either Auto or Manual. If Auto Update is enabled
status box displays Auto Update.

When the update state is Manual (Auto Update is disabled), you should refresh the window at re
intervals using the View menu’sRefresh option or the Refresh icon so that new events are
displayed.

To enable auto update:

Step 1 From the View menu, select Enable Auto Update. The message in the status box changes to Auto
Update.

Note If an indicator is displayed on the pull-down menu, to the left of Enable Auto Update, the
Auto Update application is enabled.

To enable manual update:

Step 1 From the View menu, deselectEnable Auto Update.

Note The message in the status box changes to Manual Update.
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Setting How Events Are Color-Coded
Three color-coding options are available to you. The color you choose depends on the severity o
event. The options are as follows:

• Full Color-Coding—When this option is selected, the severity information displayed has text 
colored background.

• Partial Color-Coding—When this option is selected, the Severity column is colored. The colo
the column depends on the severity of the event.

• No Color-Coding—When this option is selected, text only is displayed in the Severity column

Selecting the Type of Color Coding to Be Used

Step 1 From the View menu, selectSet Color Coding.

Step 2 From the menu that appears, select one of the options.

The selected option is implemented immediately.

Viewing the Event History
Event history allows you to display any events that match the current query criteria and have had
state changed, either acknowledged, cleared, or unacknowledged. This is disabled by default. To
this information, select the View menu’sEvent History option.

To view the event history:

Step 1 Configure the event query (refer to the “Filtering Events Using Queries” section on page 8-23.)

The Event Browser displays current events that match the criteria set in the query.

Step 2 From the View menu, selectEvent History.

The Event Browser now displays any events that meet that query and have been cleared.

Note By default, cleared events are stored by the system for seven days. Therefore, only
events that match the current query and have had their state changed in the last
seven days, are displayed when the Event History is enabled.
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Figure 8-23 Event History Enabled Screen

Refreshing the Event Window
Ensure that Manual Update is selected; this is shown as a current status message. You can then

• From the View menu, selectRefresh.

• Click the Refresh icon  on the Toolbar.

The window is refreshed.

Note You should refresh the window at regular intervals to show an up-to-date list of events.

Viewing a Full Description of an Event
Double-clicking an event displays the Full Event Description window. This provides details of the ev
with Acknowledge and Clearing details.

To view a full description of an event, place the cursor over the relevant event in the Event Browser,
double-click the left mouse button or selectEvent Description, then selectEvent Information Dialog
from the pop-up menu available on a selected object.
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A window similar to Figure 8-24 is displayed.

Figure 8-24 Full Event Description Screen

Note If the event has not been cleared, the Event State displays Active and the Clearing Method,
User Responsible for Clearing, and Clearing Time and Date sections are disabled.
The information displayed cannot be altered.

If an event has been cleared, you can view the method used to clear it by clickingClearing
Event.

The Full Event description window displays the following information:

• Object name—Name of the CEMF managed object the event was reported against

• Time and Date—The time and date the event was reported

• Severity—The severity of the reported event

• Source Domain—The Communications domain from which the event was reported

• Management Domain—The Management domain from which the event was reported

• Event Description—A brief description of the reported event

• Event State—Whether the event is active or cleared. If the event has been cleared, the Clea
Method, User Responsible for Clearing, and Clearing Time and Date sections become active
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Acknowledge Details

• Acknowledgement User—Identifies the user who acknowledged the event

• Acknowledgement Time and Date—Identifies when the event was acknowledged

Clearing Details

• Clearing Method—Indicates if the event was cleared by the network or by a user.

• User Responsible for Clearing—Displays the user name responsible for clearing the event.

• Clearing Time and Date—Indicates the time and date the event was cleared.

• Reason for clearing—The information that was entered in the Events Clearing window, which
completed when the Clear indicator is selected.

Managing Cisco MGX 8260 Faults
You can view and manage faults on the Cisco MGX 8260 with the Web View tool. To use Web Vie

Step 1 Select the Cisco MGC 8260 icon, right-click to display the pull-down menu, selectTools, then select
Open Web Viewer, as shown in Figure 8-25.

Figure 8-25 Map Viewer Screen—Tools>Open Web Viewer Option
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Step 2 When the Web Browser appears, type your user ID and password and clickLogin.

Using the Cisco MGC Tool Bar
You can manage Cisco MGC host faults and performance from the MGC Toolbar.

Step 1 Select the Cisco MGC common host, right-click to display the pull-down menu, selectTools, then select
Open MGC Toolbar, as shown in Figure 8-26.

Figure 8-26 Map Viewer Screen—Tools>Open MGC Toolbar Option

You see the screen in Figure 8-27.

Figure 8-27 MGC Toolbar

From the MGC Toolbar you can click the following buttons:

• Alarm&Meas Viewer—View alarms on the Cisco MGC host.

• CDR Viewer—View call detail records (CDRs).

• CONFIG-LIB Viewer—Configure a library.

• Log Viewer—View a log file.

• Trace Viewer—View a trace file.

• Translation Verification—Verify a translation.

• File Options—View a configuration of the files.
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• Close—Close the MGC Toolbar.

Alarm and Measurements Viewer

Step 1 On the MGC Toolbar, clickAlarm&Meas Viewer  to view alarms on the Cisco MGC host.

Figure 8-28 MGC Toolbar—Alarm&Meas Viewer Option

You see the screen in Figure 8-29.

Figure 8-29 Alarm&Meas Viewer Warning Screen

Step 2 Click Yes.

You see the screen in Figure 8-30.
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Figure 8-30 Alarm & Measurement Viewer Screen—Meas Record View Tab

Step 3 In the Select Component box, use the Comp Type and CompList pull-down menus to select valu

Step 4 In the Select Category box, use the catType and measList pull-down menus to select values.

Step 5 Select a file from the list on the right of the screen.

Step 6 Click Execute to run the query.

The results appear in the box at the bottom of the screen.

Step 7 Click theAlarm Record View tab to display alarm records.

You see the screen in Figure 8-31.
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Figure 8-31 Alarm & Measurement Viewer Screen—Alarm Record View Tab

Step 8 In the Select Component box, use the Comp Type and CompList pull-down menus to select valu

Step 9 In the Select Category box, use the alarmCategory pull-down menu to select a value.

Step 10 Select a file from the list on the right of the screen.

Step 11 Click Execute to run the query.

The results appear in the box at the bottom of the screen.

CDR Viewer

Step 1 On the MGC Toolbar, clickCDR Viewer to view CDR records.

You see the screen in Figure 8-32.
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Figure 8-32 CDR Viewer Warning Screen

Step 2 Click Yes to proceed.

You see the screen in Figure 8-33.

Figure 8-33 CDR View Screen—Query Tab

Step 3 Select an action to perform.

Step 4 Click theConfig tab.

You see the screen in Figure 8-34.
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Figure 8-34 CDR View Screen—Config Tab

Step 5 From the All Possible Message Types list, select the messages you want to filter and clickTransfer to
transfer them to the Selected filtering list.

CONFIG-LIB Viewer

Step 1 On the MGC Toolbar, clickCONFIG-LIB Viewer  to configure a library.

You see the screen in Figure 8-35.
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Figure 8-35 CONFIG-LIB Viewer Warning Screen

Step 2 Click Yes to continue.

You see the screen in Figure 8-36.

Figure 8-36 config-lib Screen

Step 3 Enter the number of the list item to be executed and pressEnter.

Log Viewer

Step 1 On the MGC Toolbar, clickLog Viewer to view a log file.

You see the screen in Figure 8-37.

Figure 8-37 Log Viewer Warning Screen

Step 2 Click Yes to proceed.

You see the screen in Figure 8-38.
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Figure 8-38 Log Viewer Screen

Step 3 Select categories and severities from the lists, then select a log file.

Step 4 Select an action to execute.

Trace Viewer

Step 1 On the MGC Toolbar, clickTrace Viewer to view a trace file.

You see the screen in Figure 8-39.

Figure 8-39 Trace Viewer Warning Screen

Step 2 Click Yes to continue.

You see the screen in Figure 8-40.
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Figure 8-40 Trace Files Screen

Step 3 Select a trace file to view and clickView.

Translation Verification

Step 1 On the MGC Toolbar, clickTranslation Verification  to verify a translation.

You see the screen in Figure 8-41.

Figure 8-41 Translation Verification Warning Screen

Step 2 Click Yes to continue.

You see the screen in Figure 8-42.
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Figure 8-42 Translation Verification Screen—DialPlan Translation Tab

Step 3 Type a four-digit dial plan number in the field provided.

Step 4 Click Execute to finish.

Step 5 Click SaveInFile to save the data in a file for later viewing.

Step 6 Click theConfig tab to display related environmental variables.

Step 7 You see the screen in Figure 8-43.

Figure 8-43 Translation Verification Screen—Config Tab

File Options

Step 1 On the MGC Toolbar, clickFile Options to view a configuration of the files.

You see the screen in Figure 8-44.
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Figure 8-44 File Options Screen

Step 2 Click a file, then click an action to execute it.

Setting How Long Alarms Are Stored
All alarms are automatically stored in the CEMF database. Periodically CEMF purges the alarms
the database to free up room for new alarms.

The alarmDeleter utility controls the deletion of alarms. CEMF does not do any archiving of old alar
but it can be configured to delete alarms of a specific age and state. Upon installation, a cron job
up to run the Alarm Deleter at midnight every night. At this time, the Deleter queries the alarm datab
deleting alarms that meet the specified criteria. The alarmDelete.ini file, shown below, allows you
define these rules.  The default is to delete cleared alarms that are seven days old.

[logger]
#include "loggercommon.include"
loggingName = alarmDeleter

[AlarmDeleter]
databaseName = [[OSDBROOT]]/alarm.db
segmentDeletionInterval = 15
ageOfAlarmsInDays= 7
ageOfAlarmsInHours= 0
ageOfAlarmsInMinutes    = 0
deleteAllAlarms= 0

[Database]
#include "databaseCommon.include"

The variables used in defining the deletion rules are described in Table 8-18.
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Table 8-18 Alarm Deleter Attributes

Variable Description

ageOfAlarmsInDays The age of the alarm, in days, before it is to be deleted.

ageOAlarmsInHourse The age of the alarm, in hours, before it is to be deleted.

ageOfAlarmsInMinutes The age of the alarm, in minutes, before it is to be deleted.

deleteAllAlarms 0 = delete only cleared alarms that match criteria; 1 = delete both
active and cleared alarms that match criteria.
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